
Important Notice !! 
This software supplied as is, with no expressed or implied guarantee of usefulness, operation or correctness.  I released this software 

because I found it useful in running an NMPRA Pylon Race. 

Most of the user interface of this program uses standard Window controls.  There may be a few features and operational techniques 

you may not be familiar with.  It is highly recommended that you read the Introduction before trying to use this software.  It is not 

long and has lots of pictures. 

he fact that you are reading this means you have the package installed.  There are additional steps to take depending on how you want 

to use this software.  It is covered in the section ‘Additional Install Steps’.  If you want to remove this software, read section 

‘Removal’. 

Also make sure you read the section ‘Requirements’.  Your computer may not be able to use this software. 

This is release 1.1.8 of this software. Once you have saved a file with a newer version, it can never be opened again using an older 

version. Make sure you have backup plans in case this software malfunctions.  Make backup copies of the race and pilot file regularly 

so you can revert back in case of serious file damage. 

Requirements 
This software has been tested on Windows 2000 Pro, Windows 7, and Windows 10.  It should run on Windows 98 and XP but has not 

been tested.  This program outputs HTML files.  This makes it easy to post results on the Internet and print them during the race.  In 

order to do any HTML file generation, you must have Windows Internet Explorer 5.0 or higher.  It was tested on IE 6.0 and IE 7.0 

but Microsoft claims it will run on 5.0.  It is recommended that you install Internet Explorer 6 or 7 with latest Service Pack. The 

program also appears to work well with Chrome. Within Chrome, you can “print” to a PDF file by changing the printer, and then post 

the PDF online. 

A pointing device (mouse) is required.  You can do almost everything without a mouse but it is much easier to use this program with a 

mouse.  A screen resolution of 800 X 600 is minimum.  Larger is recommended.  

A color inkjet printer is recommended.  All testing was done on an Epson Stylus Color 440, a low cost inkjet printer.  You can use a 

black only printer but you will not take advantage of the color highlights provided for printouts.  For example, if you are using Wing 

Flags for lane identification, the heat sheet will show the colored wing flags required above the lanes. 

You must have basic knowledge of the Windows Operating System and how to deal with programs and files.  This program will try to 

warn you when you are doing something questionable but will usually let you do it if you insist.   

Pilot Information Cards and Heat Cards are best printed on card stock.  If printed on paper, a $10 paper cutter from WalMart makes 

quick work of cleanly slicing the pages. 

And don’t forget to have additional ink cartridges for your printer before the race starts !! 

Introduction 
 

NMPRA Race is a program to help run a NMPRA pylon racing event.  It can help manage the entire event from pilot registration to 

award determination.  A variety of information displays and printouts are available in multiple formats.  Printouts are generated in 

HTML file format so you can also post the printouts on the Internet.  So let’s take a look.  The screen shots in this document were 

taken using sample face file DemoRace.nmr.  If you want to start up the program and follow along, you should see the same things 

displayed in this document.  

 

NOTE: A few of the displays will not show minor changes from the original version of this program.  

 

Two files are used when running a race: 

 

 Race File – A new file for every race.  File name = YourRaceName.NMR 

 Pilot File – A single file which accumulates pilot information for re-use with the next race.  File name = NMPRA_Pilots.NMP   



Main Screen 

When you open the program (double click on the program file), You will see the main screen. 

 

 
 

NOTE: If  ‘N M P R A’ and/or ‘We go Faster’ look differently on your computer, you do not have the fonts installed used by this 

program.  All the fonts used by this program are supplied in the install package and may be installed using the Windows Control 

Panel.    

 

You may use the toolbar button to create a new file or the standard file open menu.  Let’s open up the file DemoRace.  



 

Open Race File  

 

There are several ways to open a race file.  For this demo, we will open one from the Main Screen: 

Click the open folder button, click DemoRace.nmr in the file list then click ‘Open’ button. 

 

  
 



 Three Views of  Race 

 

When you open a race file, you will see the main view of the race, the Pilots.  If this view is closed, the race file is closed.  We will 

take a look at the additional views later.  First, let’s look at the pilots view. 

 

NOTE: The menu and toolbar changes depending on which view is currently active (being displayed in front).  To do any operation 

on the Race File, the Pilots View must be active. 

 

Pilots View 

 

 
 

Pilots View Toolbar 

 

The Pilots View Toolbar has 7 or more buttons. 

 

 
  

 Save File – Used to save the race file.  Enabled when file changes have been made. 

 Print – Print Pilot View in it’s current sorting order.  How to sort is described later.  

 Quick Print – Access to most needed printouts with only default settings 

 Matrix – Generate race matrix.  Enabled when enough pilots are registered. 

 Add – Add (register) a new pilot for the race. 

 Planes View – Bring the Planes View to the front of the windows. 

 Heats View – Bring the Heats View to the front of the windows.     

 View Class Subset Buttons – If your race has more than one class, buttons will restrict views to a single class.  The last button 

will display all classes.  In this sample of the toolbar, all classes are currently being displayed so the display all button is disabled. 



Pilots View 

  

Let’s take a look at the information you see in the Pilots View.  To the left of the pilot’s name may be various icons indicating some 

condition that exists for the pilot.  They are: 

 

  Has not paid entry fee 

  Has not signed waiver  

  Primary plane has not been safety checked 

  Has no primary plane 

  Radio frequency conflict(s) in a different class 

  Radio frequency conflict(s) in the same class 

   Pilot is registered but not actively flying.  (Will not be included in matrix)  

  Pilot was removed from the event after it has started. 

 

Notice that the window is not large enough to display all the information so it has horizontal and vertical scroll bars.  You may 

increase the window size to see more.  The default sorting order of pilots is their score.  You may sort this view by clicking on the any 

column header.  For example, if you want to see the pilots in order of their radio frequencies, click on ‘Chan’. 

 

   
 

The name column has an indicator to show a pilot is an APRA ‘9 Lapper’.  APRA (Arizona Pylon Racing Association) is a derivative 

of AMA 424 with a provision for slower pilots that they fly 9 laps instead of 10.    

 

The Low Time column has some indicators also.  A double asterisk (*) indicates this is the lowest time in the class.  A ‘C’ indicates 

the pilot has one cut on their fastest time. 

 

 
 

In any view, the column width may be adjusted by grabbing the column separator with the mouse and moving it left or right.  If some 

pilots have long names, you may wish to make the name column wider. 

 



   
 

The remaining information columns need no explanation.  Now lets look at the other 2 views 

Heats View – Heat Sheets 

 

 Once we have generated a matrix, the Heats View is available. 

 

 
 

The Heats View toolbar is different than the Pilots View in 3 ways: 

 

 There is no Save button 

 There is no Add button 

 There is a button to bring the pilots view to the front.  

 



The default information in the Heats View is Heat Sheets.  The Heat Sheets shows which pilots fly in which heats. 

 

Note that the pilots middle initial is displayed here to differentiate pilots with the same first initial and last name. 

 

The “Round.Heat” column has some indicators: 

 

 
 

The checkered flag indicates the round has completed.  Completed means the results have been entered.  In this example, the first 5 

heats have been completed.  When an entire round has been completed, the scores will appear in the Pilots View.  Note that in this 

example, Round 3 is half done so the results for Round 3 are not shown in the Pilots View. If you find an error later, you can update a 

completed heat.   

 

The Class (APRA for this example) is also displayed for the first Round.Heat.    

The alternate view for the Heats View is Heat Cards.  This shows all the details of the heats. Change to this view by the Select/Heat 

Cards menu item. 

Heats View – Heat Cards 

 

 
 

Note that the details require a wide column so you will have to scroll horizontally to see all the lanes. 

 

This view is used if a quick check of heat results is required and when you wish to print heat cards.  Keep in mind that the Heats View 

toolbar has only one print button.  Whether you print Heat Sheets (Matrix) or Heat Cards (Starting line cards) depends on the current 

view when the print button is pressed. 



Planes View 

 

 
 

This view may be used very little after the initial registration of planes is complete.  Note that the Planes View print is disabled.  

Currently there is no support for printing plane information.  As with the Pilots View, you may sort on any column. 

Additional User Interface Control 

Views may be closed instead of selecting other views which come to the front.  If you close views, keep in mind that if you close the 

Pilots View, you close the race file. 

All the window layouts shown so far are the default Windowing option, ‘Cascade Windows’.  You may maximize the views to see 

more by clicking on a view Maximize button. 

 

When you Maximize any view, all views get the entire viewing area.  You can still select any view you want to see.  The other views 

will be totally hidden behind the current view.  You can put the views back to their previous state by clicking on the view Restore 

button. 

  
 

 



You can select the Windowing option ‘Tile’ from the Main Menu Windows pulldown Menu. 

 

 
 

NOTE: There are many ways to select views other than the toolbar buttons.  You may prefer to use them instead of the toolbar.   

 

While we are on the subject of toolbars, you may choose to not have a toolbar by clicking on the Main Menu View pulldown menu 

item Toolbar. 

 

 
 



You may dock the toolbar by dragging it with the mouse another position on the main window. 

 
 

Or you may undock the toolbar by dragging it with the mouse. 

 

 
 



This software has a feature called ‘Context Menus’.  These are menus that popup when you click Mouse Button 2 (right mouse 

button).  The menu that pops up will vary depending on where the mouse pointer is when you click mouse button 2.  The menu will 

have only items that apply to the window you are currently over.  The menu items available will depend on the condition that 

currently exists in the window, such as an item being selected. 

 

If you click mouse button 2 on a “Round.Heat” item (selecting it) in the Heats View window, you will get the Heats View Context 

Menu with items enabled that are currently available. 

 

 
 

 

To get the Context Menu for the Race you can click Mouse Button 2 on the checkered background of the main window.   

 

 
 

 

This concludes the Introduction.  You should be able to open the DemoRace file and display information in various formats.  Now we 

will go though the steps required running a race. 

 



Running a Race 
 

Running a race is broken down into 3 phases: 

 

 Prepare 

 Execute 

 Finish 

 

Prepare 

 

To prepare for a race: 

 

 Create Race File 

 Register Pilots 

 Register Planes 

 Generate Matrix 

 Print Pilot Info Cards 

 Print Heat Cards 

 Print Heat Sheets   

 

Create Race File 

 

Start up the program and click on the New File button (The blank white document) 

 

Enter the race properties in the dialog.  The RaceDemo is a race with classes APRA and 428.  

 



 
 

The properties are: 

 Title – Keep the title short to avoid printing width problems 

 File – The default file name will be ‘RC’ followed by the GMT date. The file name should end with “.nmr”. This extension 

will be added if left off. 

 Matrix Type – In this version, there is only one Matrix type so you cannot change it. 

 Classes – You must select at least one class from the standard AMA classes. Or you can have one class that you name. If you 

select FAI or Name Your Own, that is the ONLY class that can be in this file. You can have multiple files, one for each 

class. It is strongly recommended that only one instance be open at a time, especially during race prep. 

 Staggered Start – Check if you will be staggering heat starts using two start flags. 

 Limit Channels – Check if you want to limit the quantity of radio frequencies.  If checked, an additional dialog will appear to 

set the limits. 

 Fast Pilot Registration – This option is for getting a race started quickly.  You need only enter a Pilot ID number, name  and 

radio frequency to get a race going quickly.  You would probably use this for small club races.   WARNING ! – This option 

assumes the Planes are safety checked.    

 Maximum 3 Lanes – Limit the matrix to 3 lanes instead of 4 

 Heat Scoring 

 AMA – Pilots can get one cut and continue racing but must complete an extra lap. 

 1 Cut = 1 Point – Pilots can get one cut and continue racing but get only one point for finishing. 

 Manual – The program will score pilots but you can change the scores. 

 Wing Flag Lanes - Set the lanes for the positions (High/Low)  and colors of the lane ID stripes.  

 Award Places – How many places will get awards.  For example, if you were giving trophies for 1
st
, 2

nd
 and 3

rd
, you would 

enter 3. 

 Resolve Ties – Check the way ties will be resolved to determine finish position at the end of the race.  Until the race is 

finished, Fast Time determines the sort order for pilots when sorted on Points. 

 Save Reminder – If checked, program will remind you to save your race file every nn changes.  

 Print – The print settings are described in the Section ‘Printing’.   



Register Pilots 

 

Click on the Add button (plus sign).  You will get the Pilot dialog.  Here you enter general information about the pilot and 

information specific to this race.   You cannot complete the registration of a pilot until all required information is entered.  For 

example, you cannot register a pilot without a name, radio frequency, class entered, etc.  If you have ever entered the pilot in a 

previous race, the pilot file (NMPRA_Pilots.NMP) will still contain the pilot information. 

 

If this is the case, you can enter the Pilot ID (AMA number) by typing it in and tabbing to the next field or selecting it from the Pilot 

ID drop down list. 

 

 
 

A pilot is assigned a sequential Pilot Number that uniquely identifies a pilot flying in a class.  If a pilot registers in multiple classes, 

they will be assigned multiple Pilot Numbers.  If you are using a registration form with sequential pilot numbers, you may want to 

have pilots flying in multiple classes, enter their name multiple times.  Then you can register the pilots using this software from the 

paper registration form and the pilots will be assigned the same pilot number as on the form. 

 

If the pilot was entered in a previous race and information about the pilot has changed since last registered, such as address, phone 

number, etc. it may be changed now. 

 

Note that Channel (Radio Frequency) defaults to –1 to force you to enter a channel.  Channel zero is valid. 

 

Pilots flying the 'Spread Spectrum' type radio equipment do not have a specific channel. Pseudo channels 100 - 199 are used for these 

type radios. If you have a racing team that wants to be in the same matrix lane, assign them the same channel just as you would for 

real channel numbers.  

 

Pilot Status has 3 conditions: 

 

 Active – Pilot is ready to race.  It is always a good idea to mark a pilot who is NOT ready to race (maybe out of aircraft) as 

NOT Active.  A pilot who is NOT Active, will NOT be included in a Matrix but will appear in the results if they have any 

points.  This setting is of use when many pilots cannot continue racing and you wish to re-matrix the remaining heats to 

compress out the pilots who will not be flying.  You would not do the re-matrix unless a significant number of pilots had 

become inactive.  When you re-matrix, pilots may change lanes.  If you are using wing flags for lane identification, pilots 

who change lanes will have to remove them and add new ones.  In addition, when you re-matrix, you must also print the 

following: 

 Heat Cards 

 Heat Sheets 

 Pilot Info Cards  

 Paid – The pilot has not paid the entry fee or there is no entry fee.   

 Signed Waiver – The pilot has signed the Safety Waiver Document. 

 Disqualified - The pilot was found to be violating a rule. 

 



 
 

A 'Category' input allows you to categorize pilots. This input, which would usually be one letter or number, may help you if you are 

manipulating the heats matrix after it is generated.  For example, you are running a race with pilots from Arizona and California. You 

could categorize the pilots as 'A' or 'C'. Then you can more easily see the effects of matrix changes to get the best mix of Arizona 

pilots flying against California pilots. In most cases the category only displays on the matrix view.  It not printed on any forms. 

NEW FEATURE: If the Category is a number for all pilots, then it is treated as a “power” ranking, and does impact the matrix. A 

higher number is a stronger pilot. The code will try to balance the power among all lanes. If the power numbers are all 1 through 4, 

then the code will balance the overall power sum of each lane, as well as the quantity of each power level. There is not a need to have 

equal quantities of each ranking, nor to utilize all numbers from 1 to 4. If not all pilots have a power ranking, they are ignored. 

Lane 1 affinity will give a preference to put that pilot and his team in lane 1. This does not affect matrix building, but rather swaps 

entire lanes after they have been assigned. This is primarily for the CD at a large contest to have a predictable time to fly each round, 

helping him focus on running the contest. Only one person should have lane 1 affinity, his entire team will be placed there. In some 

cases, other priorities in the matrix building will mean the affinity cannot be honored, but that person will be placed in the next 

feasible lane. 

The pilot status affects the Pilot View display.   

Spreadsheet Import 

At some larger contests, the entries prior to race day are managed in a spreadsheet. A new feature allows import of pilots from a 

spreadsheet that is correctly formatted. To access this feature, in Pilot View, select the menu choice “File/Import Pilots”: 

 



The imported pilots are entered in “Qucik Entry” mode, meaning they only have the required fields of AMA number, name, and team 

filled in. The pilots are entered as if you selected them by AMA number in the Add Pilot dialog. If any conflicts occur, such as 

duplicate names, duplicate AMA numbers, etc., the error is flagged in a dialog and the line is ignored. The pilot import can be done in 

conjunction with normal addition of pilots, both before and after. 

 

The pilot import spreadsheet must be saved as a “.CSV”, or Comma Separated Variables file. This can be done through the File Save 

menu on most spreadsheet pograms. A sample import file is included. The file must have 4 to 5 columns: 

 

 
 

The first 4 columns are mandatory and self-explanatory. The fifth colum is the optional category or power ranking. Any additional 

columns are ignored. The first row is a header line, and is also entirely ignored. Only one brackaet or class can be imported at once. 

The code will ask you to selet the class if mutliple classes are available in the race. You can do multiple imports for multiple classes. 

Carefully verify that the entire list is imported. If an error line is flagged, that pilot can be manually added, or the race can be closed 

without saving, re-opened, the mport file modified, and import tried again. If the file is currently open in excel, NMPRARace may not 

be able to open it. 

 

From the adjacent menu location, you can export the race results to a CSV file with very similar format. The exported file has all 

classes, and has an extra header line for each class. The exported file also has the pilot points and times. Note: The export file ALSO 

contains the category, so if sharing elsewhere, you probably want to delete that column. The greatest use of the export is in the case of 

an A/B preliminaries followed by a finals race, such as at the AMA nationals. The prelims can be exported, the top finishers copied 

from both races and pasted to a new import file. If the teams were accurately labelled across the A/B matricies, then the teams will eb 

intact in the import file for the finals. The scores and times are ignored, so they can be left in the file. 

 

After pilots are registered. They may be changed by opening the pilot in the Pilot View and entering the changed information.  There 

are several ways to open a pilot; 

 

1) Select the pilot by clicking on the pilot’s name. Then select main menu Edit, Change. 

 

    
 

2) Select the pilot by clicking on the pilot’s name with Mouse Button 2 (Right Mouse Button). Then select menu Change. 

 



 
 

3) The easiest way is to double click the pilot’s name. 

Register Planes 

 

When a pilot is registered, a plane is also registered to the pilot.  The plane is assumed to have not been safety checked.  To update 

the registered planes, select the Planes view and select the plane.  Planes are selected from the Planes View the same way pilots are 

selected.  When you select a plane you get the Plane dialog.  Enter any information you have.  The Type, Main Color and Engine may 

be entered if you chose to.  They may be typed in if the drop down list does not contain what you want. 

 

 



 

Note: If a pilot’s plane is not safety checked, the pilot and plane list will indicate this unsafe condition and you will not be able to 

generate a matrix until it is corrected. 

 

 
 

Generate Matrix 

 

Once all pilots and planes have been registered, you may generate the matrix by clicking on the Matrix button. 

 

 
 

 

You will get a dialog asking you: 

 

 Begin Round – Must be 1 for the first matrix generated 

 End Round – A good idea to matrix more than you will need.  You can finish a race early. 

 Classes to be matrixed. 

 Roll count and direction is no longer needed, as the matrixing is highly randomized, and each time the matrix is built the 

ordering and lanes will be different.  

 Indication that you want to be informed of reasons you might not want to matrix.  Like pilots have not signed the Waiver.    

 

WARNING: When re-matrixing, is is highly likely (guaranteed) that most pilots will end up in different lanes! It is STRONGLY 

recommended that the matrix be posted for viewing at least 5-10 minutes BEFORE stickers are provided, to ensure no teaming 

mistakes are made. If pilots are changed or added, rematrixing will be required! Since the matrix is no longer deterministic, this 

means major shuffling. 

 

If simply adding a round or two to a prior matrix, you will be offered the chance to keep the pilots in the same lanes. IF YOU HAVE 

CHANGED PILOT INFORMATION, do not keep pilots in the same lanes, but accept rematrix. However, if you are simply 

extending the contest, be sure to reject the offer to re-matrix! If you do keep the pilots in the same lanes, it will be up to you to verify 

that all pilots registered are in the matrix! 

 

If the code does not detect changes, you are offered the following: 

 
This is often the case if you are changing the number of rounds. If you have already published the lane assignments, this allows you to 

keep those assignments whiel extending the matrix. 

 



If changes were detected, you are offered a similar dialog: 

 
 

This is often caused by changes, such as new pilots, deleting pilots, or changing teams/frequencies. In virtually all cases, you would 

answer YES here and accept the re-matrixing. Similar dialogs are offered after the race starts. Note: If you select to NOT rematrix, 

and the code sees that the NUMBER of pilots has changed, then the whole operation is halted and a warning is thrown. However, the 

code does not currently perform a pilot-by-pilot comparison. 

 

Once the matrix is generated, the Heats View will be enabled to see the matrix. 

Print Pilot Info Cards 

Now that we have a matrix, we can print the Pilot Info Cards.  These cards are usually printed on card stock, cut out and given to each 

pilot.  The pilot can confirm the information on the cards.  The cards then serve as a reminder of which heats they fly in.  The pilots 

may also jot down results on the cards when a heat is complete.  You print the pilot info cards by selecting the Pilot View, then drop 

down the File menu and clicking on Print Info Cards… 

 

 
 

 

   A pilot info card looks like this. 

 

 



 
 

Note that staggered start and color printing are being used so the pilot knows whether to start on the first or second flag in a heat when 

doing staggered start. 

Print Heat Cards 

 

To print Heat Cards, select the Heat View by clicking the Heat View button on the toolbar 

 

 
 

Then select Heat Cards by clicking in the Select Menu, Heat Cards. 

 

 
 

Then click the Print button on the toolbar 

 

 
 

You will get a dialog asking you what type of Heat Details you want to print.  Select Heat Cards. 

 



 
  

You will then get a dialog asking which rounds, classes to print and the date you want on the cards. 

 

 
 

 Heat Cards are normally printed on card stock, cut out and sent to the flight line.  A heat card looks like this. The ID Round Start 

Card will print the words 'Start Round' on the first heat card for every round. This can remind start line personnel that a new round is 

starting.  

 

 
 



NOTE: Heat Cards for FAI do NOT contain the Finish column and are limited to three pilots. 

 

Note that staggered start and color printing are being used.  The green pilot(s) go on the first flag and the blue on the second. Also, 

the option of printing lane flags on lane numbers is set on for the race. 

Print Heat Sheets   

 

The Heat Sheets (actually one continuous sheet which spans multiple sheets of paper) are printed like Heat Cards except the Heat 

Sheets view is selected before printing.  When printing Heat Sheets, there are a few minor differences in the dialogs you will respond 

to.  The Print Heat Sheets dialog has two additional items: 

 

 Show Wing Flags – Print images over each lane showing how wing flags are placed depending on your lane.  

 Icons – Print the icons seen in the Heat Sheets View.  This will show which heats are finished if you are re-printing Heat 

Sheets after starting a race. 

 

 
 

A Heat Sheets printout looks like this. 

 



 
 

This example shows only the first 8 heats.  There normally would be multiple printed pages which you can tape together to make one 

continuous Heat Sheet. 

 

 

Quick Print Menu 

A number of event operators requested a simple way to print EVERYTHING needed for a race without having to go looking through 

various views. A new dialog, Quick Print, is available through the File/Quick Print menu item, or through the Toolbar Icon: 

 
 

 

The Quick Print Dialog comes up, and allows selection of multiple items to print at the same time: 



 
 

Note that if multiple calsses or brackets are in the race, you can select to print just one or all. However, in some cases the code may be 

hard-wired to print all. Only the classes in the race file are displayed, and only those that have been matrixed are active. In the sample 

case, 426 is ready to print, but Q40 has not yet been matrixed. If mutliple items are selected, they will all print.  

 

The Quick Print routine sets all defaults, and so no sub-dialogs are presented. The printouts are set to directly print (not manual later 

print). Only one copy is printed. You can repeat for more copies, or go to the html subdirectory, open the desired html file, and print 

as many copies as needed. This is particularly useful for Spectator handouts. At most local races, only the first two Pre-Race items are 

printed, and only result sheets during and after the race. As in the normal pilot view, the results sheets depend on the sort order 

selected, which in most cases should be by points. 



Execute 

 

To execute a race: 

 

 Write Heat Results 

 Enter Heat Results 

 Print Current Standings 

 Respond to Pilot Questions 

Write Heat Results 

 

At the flight line or judges timing station, the results of each heat are written on the Heat Card immediately after the heat is finished.  

Written on the card are: 

 Fin – Finish position 

 M:S:HH – Time in minutes, seconds and hundredths 

 Cts – Cuts 

 DN – Enter ‘S’ for Did Not Start, ‘F’ for Did Not Finish 

 Pts – Points  - 0 for 2 cuts, DNS or DNF.  First place gets 3 if 3 lanes heats, 4 for 4 lanes heats, etc. 

Enter Heat Results 

 

To enter heat results from the Heat Card, Select the Heats View by clicking the Heats View Button on the toolbar. 

 

 
 

Then select the heat to be entered.  You open a heat the same way you open a pilot or plane.  The easiest was it to double click on the 

heat Round.Heat number in the left column which matches the Rnd Heat numbers on the Heat Card.  When you open a heat you get 

the Heat Update dialog. 

 

   
 



Times are pre-set to times which are typical for the class being entered.  This example is for a 3 lane heat so there are only 3 pilots 

shown.  If a pilot Did Not Start or Did Not Finish, you need only click on them.  If a pilot got 2 cuts, you need only set Cuts to 2.  For 

all other cases, the Finish position and Time must be set.  If there was no time measured, you should set 0:0.00 for a time.  When you 

click on OK, you will get the following confirmation dialog.  You should confirm that the scores on the Heat Card agree and resolve 

any differences with the person who filled out the Heat Card. 

 

NOTE: When scoring FAI heats, the finish position will not be displayed. 

 
 

    

Print Current Standings 

 

You will probably want to print the current point standings periodically throughout the race.  To print pilot point standings, select the 

Pilot View.  If the Pilot View is not already the current view, click on the Pilot View button on the toolbar. 

 

 
 

 

Sort the view by pressing on the Points column header. 

 

 
 

Press the Print button on the toolbar.  You will get a dialog to select the columns you wish to print.  The items checked are probably 

the ones you want. You can also use he Quick Print Feature in any view, form the File menu or the toolbar. 

 

NOTE: To print a detailed pilot score listing, select Print Heat Details from the File menu or the Pilot View context menu. 

 



 
 

The pilot standings print will be one or more sheets that you can tape together. 

 



 

Respond to Pilot Questions 

 

Pilots have questions during a race about procedures, conditions and events.  Many of these questions can be quickly answered using 

this software.  For example, a pilot might ask the question ‘Who is on channel 24’.  To answer this question, sort the Pilot View on 

the Channel column.  You will easily see who is on Channel 24 and the class or classes they are flying in using Channel 24. 

 

NOTE: For the previous example, make sure you are displaying all classes to get the correct information.  

 

Finish 

 

To finish a race: 

 

 Enter final Heat Results 

 Resolve Ties 

 Print Requested Details 

 



Enter Final Heat Results 

 

The trigger to finish a race is the entry of the results for the final heat.  If you are not flying all rounds generated, you may force a 

finish by clicking on the ‘Finish’ menu item in the Pilots View File Menu or the Race Context Menu. 

 

 
 

Resolve Ties 

 

The finish race trigger will check if you are resolving ties with fast times or fly-offs.  If you are resolving ties with fast times, the 

Pilots Points Standing (Pilot View sorted by clicking on the Points column header) will sort by points and fast times so you already 

know the final race finish position for all pilots.  If you are resolving ties with fly-offs, this software will check for ties within the 

Award Places you set when defining this race.  If any ties exist, you will get information dialogs showing who is involved and if there 

are any radio frequency conflicts between tied pilots. 

 

 
 



 
 

All pilots involved in ties will then have zero fly-off points indicated in the Pilot View. 

 

 
 

You may then proceed with the fly-off heats.  Note that blank heat cards are supplied in the HTML folder fly-off heats. 

 

When fly-off heats are complete, you may enter fly-off points for the tied pilots by selecting the pilot with Mouse Button 2 and 

selecting the FlyOff Points menu item. 

 

 
 

 

Then the Points Standing will be sorted by points and then fly-off points instead of using fast times.  The fly off points are displayed 

in the Pilots View and prints.  If you change your mind and decide you want to resolve ties using fly-offs, change the race properties 

to indicate this, then click on Finish. 

 

 
 

The Flyoff Points dialog now asks for time and cuts. AMA rules indicate that flyoff times qualify for Fast Time trphies, as well as 

personal best times (displayed on results). NOE: If any race scoring is changed after flyoff entry begins, then the flyoff entries are all 

reset to 0 and you need to start again. Be sure all race results are entered properly before you start to enter flyoff information. 

 



Print Requested Details 

 

Sometimes, pilots will request detailed results printouts.  You may print detailed heat results for the entire race or just for an 

individual pilot.  If you want to print for an individual pilot, get their Pilot Number from the Pilots View.  To print heat details, select 

the Heat Cards from the Heats View and click the print button.  In the first dialog, select Heat Details.  You will then get a dialog 

asking if you want details for all pilots or just one.  The heat details look similar to the heat card printout. 

 

 

Print Event Sponsor Images 

 

Some race events have sponsors. It is a good idea to display their logo. This program will print from one to four sponsor images on 

Race Results. To use this feature, you must supply from one to four JPEG images. The images must be in the HTML/img directory. 

For this to function correctly, the images must have two characteristics: 

 

1. They must be small enough to fit on the printed page. Test the images and reduce or enlarge them using an image editor. 

2. They must be named Sponsor1.jpg through Sponsor4.jpg 

 

If you post the results on the Internet using the generated HTML files, don't forget to include the sponsor images. 

 

This concludes what you need to know to use this software to run a race.  Additional dialogs are described in the section ‘Printing’.  

As you use the software, you will discover additional features. 

    

Printing 
 

Printing can be a source of serious problems.  This software was tested on an Epson Stylus Color 440 printer.  It is inexpensive and 

prints well on regular paper or card stock.  This software does not detect what type of printer you have or your printer’s capabilities.  

There are so many printer variations, even among brands that it is impractical to try supporting a large number of ‘popular’ printers. 

 

You have two Race File properties you can set to help deal with print problems: 

 

 Color – If you have a black only printer set color off.  You will lose the color highlighting benefits. 

 Resolution – The Heat Cards and the Pilot Info Cards are supposed to print 4 to a sheet of card stock.  If they do not, you can 

try adjusting this to make them smaller or larger. Also see section 'Printing Problems' where you can set the print page 

margins for Internet Explorer, the program used for all printing. 

 

There are two Race File properties to control Heat Card printing: 

 

 Heat Card Lane Colors - Print the wing flag colors on the heat card lane numbers. 

 Heat Card Round Page Break - Printing heat cards starting a new page for each round. 

 



Printing Problems 

NOTE:  

 

If you select the ‘Print Now and Keep Files’ printing option, the printing takes place in the background.  Printing takes a lot of 

computer resources and the background printing process may take a long time.  If you close the program before all the printed files 

are in the print job queue, you will lose them. However, on most modern printers, this is not an issue and the Print Now (or Quick 

Print) can be successfully utilized. 

Multiple Pages 

 

Some systems may have problems queuing up a large number of printed pages, such as Heat Cards.  This usually happens on 

machines with limited memory or older versions of the Operating System and Internet Explorer.  If you are having a problem using 

the ‘Print Now and Keep Files’ option, you can manually print the individual pages instead of queuing them for automatic print. 

 

Manual Print (Recommended) 

 

Select the ‘Keep Files for Manual Print’ option.  This will generate the print page files but not queue up multiple copies of Internet 

Explorer running at the same time. 

 

 
 

The generated HTML files will be in the NMPRARace\html folder.  Display them using Windows Explorer. You can make this easier 

by putting a shortcut to the HTML folder on your desktop. See section 'Additional Install Steps' for instructions on how to do this. 

 

 



 

One at a time, double click to open the HTML files.  When Internet Explorer is displaying the file, press the Internet Explorer Print 

button. 

 

 
Give Internet Explorer enough time to get the file into the print queue.  An icon will display on the Status Bar at the bottom of the 

window while the print queuing is taking place.  

 

 
 

NOTE: You may make this process easier by leaving the Internet Explorer window open and changing the HTML file name in the 

address bar by typing over the page number 1,2,3 etc.  

 

 
 

After changing the file name, press the Refresh button to view the next page so you can print it. 

 

 
 

Black Separator Bars 

 

The Heat Sheets put a black bar between rounds to make viewing easier.  If you view the Heat Sheets using Internet Explorer, you 

will see the black bar but it may not print. 

 

If you have this problem: 

 

1. Open Internet Explorer 

2. Select the ‘Tools’ Menu 

3. Select ‘Internet Options…’ 

4. Select the Advanced tab 

5. Check Printing option ‘Print background colors and images’ 

 



NOTE: If you do this and use the same machine for printing pages from the Internet, you will print background images and colors 

which you probably do not want.  

 

 

 

 
 

Page Headers and Footers 

 

Internet Explorer will print the page address and page number by default.  This wastes printed page space and may cause overflow.  

To configure IE to not print these headers and trailers: 

 

1. Open Internet Explorer 

2. Select the Print Menu 

3. Select 'Page Setup…' 

4. Blank out the Header and Footer 

5. You may also change the margins here if desired. 



Pilot File Utility 
 

A utility program PilotUtility.exe supports exporting the long-term pilot file database NMPRA_Pilots.NMP to a comma separated file 

(.CSV). This file may be edited using a text file editor or imported into a spreadsheet program. After desired changes are made the 

CSV file may then be imported into the Pilot File. This is separate and different from the import/eport in the NMPRARace Pilot View 

menu, which is for importing and exporting the current race. 

 

WARNING: The import operation is a total replacement of the pilot file. It does NOT just add the pilots in the CSV file. 

Additional Install Steps 
 

The installation of the program by running the self-extracting zip file will NOT put an entry in the Windows Start Programs Menu. 

The best way to make it easy to run is to put a shortcut on your desktop to NMPRARace.EXE and the html folder.  To put a shortcut 

on your desktop: 

 

1. Right-click (Mouse button 2) an open area on the desktop. 

2. Point at 'New'. 

3. Click 'Shortcut'. 

4. Click Browse button. 

5. Click the + sign for the drive where you installed the Race package (probably C). 

6. Click the + sign for the folder NMPRARace. 

7. If you are creating a shortcut to the program, click on NMPRARace.exe. If you are creating a shortcut to the HTML folder, click 

on it. 

8. Click the Next button. 

9. If you do not like the default name, change it. You probably don't want the '.exe' extension of the shortcut name for the program. 

10.  Click the Next button. 

11.  If you want to move the shortcut, click on it with mouse button 1 and hold the mouse button down while you drag it to where you 

want it on the desktop and then release the mouse button.  

 

Now you can more easily start the program or view the html files by opening the shortcut. 

 

Here is what the shortcuts to the program and html folder would look like on your desktop. 

 

 
 

WARNING: If the shortcut icons do NOT have the arrow in the lower left hand corner, you have put the program or the folder on the 

desktop. They will NOT function properly being on the desktop. They must be in the NMPRARace folder. 

 

Removal 
 

If you installed in the default directory of NMPRARace, you may delete this folder and everything in it.  Use caution because you 

may be deleting race and/or pilot files that contain valuable data.   

 


